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Item Quantity Unit 

Basic 

Version 

Scan head 1 set 

Adapter 1 pc 

Power line 1 pc 

Aviation plug 1 pc 

Calibration board 1 pc 

Mark points 1 set 

Installation Guide 1 pc 

Industrial Pack 

（add-on module） 

Turntable 1 pc 

Tripod 1 pc 

Scan head tray 1 pc 

USB line 1 pc 

Power adapter 1 set 

Power line 1 pc 

Color pack 

（add-on module） 
Texture camera 1 pc 
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Model EinScan-Pro 

Scan Mode 
Handheld HD 

Scan 

Handheld Rapid 

Scan 

Fixed Scan（With 

turntable） 

Fixed Scan

（Without 

turntable） 

Accuracy 0.1mm 0.3mm 

Single Scan 

Accuracy: 

0.05mm 

Single Scan 

Accuracy: 

0.05mm 

Scan speed 
90,000points/

sec 

550,000points/se

c 
Single Scan: <2sec 

Single Scan: 

<2sec 

Point distance 
0.2mm~3.0m

m 
0.5mm~3.0mm 0.16mm 

Single Scan 

Range 
210*150mm 

Light source White light LED 

Part Size Range 

(Recommend) 
0.03m~4m 0.15m~4m 0.03m~0.15m 0.03m~4m 

Align Mode Markers Align 

Feature Align 

Markers and 

Mixed ( shall be 

bought ) 

Feature Align; 

Turntable coded 

targets; 

Markers 

Compatible: 

Mark Point Align 

Feature Align 

Turntable Align 

Texture Scan No 
Yes (texture scan camera and software module shall be 

bought) 

Outdoor 

Operation 
No (affected by strong light) 

Special Scan 

Object 

-- 
Rich Surface 

Feature needed 
-- -- 

For transparent, reflective and dark object, please spray powder first 

before scanning 

Printable Data 

Output 
Yes 

Data Format OBJ, STL, ASC,PLY,3MF 

Scan Head 

Weight 
0.8KG 

System 

Support 

Win7/Win8/Win10 

64bit 

Computer 

Requirements 

CPU: I5 or Higher; Display card：NVIDIA GTX660 or higher; Display memory：>2G; 

Memory Storage：8G or more 

 

Specification Parameter 



6 
 

 

 

 

 

 

 

 

 

  

 

2 

nstalla

tion 

Instruc

tions 



7 
 

 

Basci Module 

Connect one end of the line to the scanner, the other end to power line and USB on the 
computer as shown in the picture. Connect to USB2.0 or USB3.0. (This installation mode is 
suitable for Handheld Scan.) 

 

 

Industrial module installation 

Put the basic module on the tripod when the installation finishes. Connect the long-opening 
end of USB line to the computer, the square-opening end to the turntable. Then connect the 
power adapter to the turntable and adjust the position of scan head and turntable. (This 
installation mode is suitable for Fixed Scan.) 

 

Hardware Installation 
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Firstly, enter the Support page: http://www.einscan.com/support. Click “Software download”, as 

shown below: 

 

Secondly, please complete the registration, if registered, click log in. 

 
After take the survey, it will enter the page http://www.einscan.com/software-download 

 

Finally, click the icon to jump to the page of any file to download the software. 

 

 

 

Software download 

http://www.einscan.com/support
http://www.einscan.com/software-download
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 Software Installation 

Double click installation package, Follow the instructions as the window pops up. Users can 

either choose the default installation path or click the Browse button to select the installation path. 

Default installation is suggested.  

When installation is finished, there will be a shortcut of the software  and  on the 

desktop. 

The shortcut in the Start Menu is shown as below: 

 

The shortcuts are: 

Software 

File Preview Tool  

Teamviewer 

Uninstall 

 

 

In the next step, connect the device and check 

whether the camera driver installation is successful, right 

click “Computer”, choose “Computer Management”-

“Device Management”-“Imaging devices” to check if the 

two cameras display normally (two cameras will be 

found when there is no color module). 

When there is color module, check if there are three 

cameras, as shown below. 

 

Software Uninstall 

Open the start menu, choose Shining3d_EinSca-

Pro----Click “Uninstall” or go the Control Menu to 

uninstall. 

  

Software installation 
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The software provides Fixed Scan, Handheld HD Scan and 

Handheld Rapid Scan, and taking into account the portability 

and high-precision. 
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Mode selection 

 Fixed Mode 
(1) Fixed Scan ( With Turntable ): This mode is recommended for objects within the size of 
200*200*200mm. For example, small workpieces. 

(2) Fixed Scan ( Without Turntable ):This mode is recommended for objects over the size of 
200*200*200mm, while high details and resolution, as well as a comparative stable environment 
(without obvious vibration) are required. For example, industrial parts which require high details 
and resolution. 

 Handheld Mode 
(1) Handheld HD Mode：When the size of the object is over 30*30*30mm, environment is not 
stable or with vibration, sticking mark points on the object is allowed, high resolution and details 
are required, this mode is recommended. For example: Industrial part, sculpture, or art works 
with rich details. 

(2) Handheld Rapid Scan：When the size of the object is over 150*150*150mm, environment is 
not stable or with vibration, surface is not with much detail pattern, this mode is recommended. 
For example: Human body (the whole body, face, chest, hand, foot and other parts), sculpture 
that doesn’t require high detail. 

 

Mark points stick 

Stick mark points on the object in random, avoiding sticking in one line. The single scan range 

is 300mm X 170mm, public areas alignment require at least four mark points. While placing the 

points, uniformly stick the mark points on the object, and make sure that in each single scan area 

has at least 4 points. 

 

Special objects  

 Before scan objects in transparent, semi-transparent or black shall spray on the surface. 

 

 

 

 

 

 

  

Scan Preparation
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Choose the device “EinScan-Pro”, as shown below. 

 

3.2.1. Help Mode for Beginners 

Close Help Mode for Beginner by clicking the top right corner . To open 

Help Mode for Beginner, go to Menu -> User Setting ->Help Mode for Beginner 

 

3.2.2. Obtain License File 

When a warning of license file doesn’t match the scanner pops up when entering scanning mode,  

the license file can be acquired by clicking “ Activate” 

 

3.2.3. Operation Procedure 

Operation Procedure 

First Scan
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First Scan 
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Click from the upper right to open drop down menu. 

 

3.3.1. Language 

This software version is including Simplified Chinese, Chinese, English, German, Japanese, 

Spanish, French, Korean, Russian and Turkish. Language can be switched in the choose device type 

and choose scan mode interface. 

 

3.3.2. TeamViewer 

By clicking TeamViewer, you can go to the TeamViewer interface directly without installation.  

Drop down Menu 
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3.3.3. Feedback 

If you have any questions, or suggestions, please share with us by clicking “Feedback”. Leave 

your email in “ My E-mail”  

 

 

3.3.4. User Setting  

 

3.3.4.1. Debug window 

Tick the checkbox to open debug window; if you want to close it, unselect it.  

3.3.4.2. Help Mode for Beginners 

Help Mode for Beginner is the default selection, which is to guide the new users make a scan 

completely step by step. Close Help Mode for Beginner by clicking the top right corner 

. To open Help Mode for Beginner, go to Menu -> User Setting ->Help 

Mode for Beginner 

Drop down Menu 
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3.3.4.3. Handheld mode saved project automatically 

Tick the checkbox of “Project will be saved automatically when the scanning is paused 
under handheld mode”, when pause scan, project will be saved automatically under 
handheld HD mode and handheld rapid mode .  

3.3.4.4. User Experience Program 

To help us improve the quality and user experience of Einscan, we hope to be allowed to 

collect usage information to Einscan Team. This information will not identify you and does not 

include your project data. By default, this checkbox is selected, and we strongly recommend you 

to select it.   

3.3.5. Factory Default 

System setting (brightness, turntable steps), calibration data will restore to the factory default 

settings. Language will be changed into English as default. Factory Default will require software 

restart.  

 

3.3.6. Einscan Community 

 

Official Website ( http://www.einscan.com/ ) refers to SHINING3D official website for product and 

information. 

Community ( http://www.einscan.com/einscan-experts-forum ) refers to SHINING3D forum for all 

EinScan users to discuss and share the experience. 

Facebook (https://www.facebook.com/groups/einscan ) refer to facebook for Einscan users to 

discuss and share the experience. 

3.3.7. About  

Software version information, and technical support mail can be found here.  

Drop down Menu 

 

http://www.einscan.com/
http://www.einscan.com/einscan-experts-forum
https://www.facebook.com/groups/einscan
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 You can open file preview tool  through a desktop shortcut or from the start menu. Start 

previewing by dragging the file into the window. Supporting formats include asc., stl., ply., obj., and 

3mf. As the picture shows below, file path shows in the title bar. 

 
  

Drop down Menu 
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Scanning cannot be entered if calibration is not done after 

installing the software. There is a WARNING: No calibration 

data, please calibrate first. 

4 
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After software installed, in the choose device type interface choose “Pro”, click “Next”, the 

software will enter the calibration mode. 

It will show the below picture if the device only has two cameras. (Texture camera is not attached). 

The left side guide bar include camera calibration and HD calibration. 

 

 

It will show the below picture if the device has three cameras. (With texture camera). The left side 

guide bar include camera calibration , HD calibration and white balance calibration. 

 

There are two calibration steps if the device without texture camera: 

①camera calibration ②HD calibration; 

There are three calibration steps if the device with texture camera:  

①camera calibration ②HD calibration ③White balance calibration. 

 
 Take the scanner with texture camera as an example (without texture camera, it only takes the 

first two steps). 

  

Note:  

Calibration board SN is under the camera viewport, you should choose the 

corresponding calibration board. 

Calibration 
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The left side of camera calibration interface is guide bar, right side is calibration video.  

 

Calibration board need to be placed in five positions during calibration, each captures five pictures. 

Place the board according to software guide.  

 

First, adjust the distance between projector and calibration board (350mm-450mm) according to 

software guide. Step 1, place the calibration board flatly in accordance with the direction in the 

picture, keep the cross pattern projected by the scanner in the white frame on the calibration board.  

Note: During calibration, keep the scanner perpendicular to the plane which places the calibration 

board, as shown below. 

 

 

Click  in the software or  on the scanner to capture snaps automatically. During 

capture process, software picture shows the scanner projecting light. Move the scanner from top 

to bottom or from bottom to top, until the rangefinder is filled in green, which means Step 1 

capture is finished, with software giving a beep sign. During capture, lift the scanner up when 

software shows “too close”; move the scanner down when software shows “too far”. 

 

 

When pictures of one position are well collected, the software will turn to the next position with 

Note:  

1. When the distance bar is ticked, it means pictures of this position are 

collected. Blue means the current position. 

2. Keep the cross in the white square area when moving the calibration. 

3. During calibration, keep the scanner perpendicular to the plane which places the 

calibration board 

Camera Calibration 
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buzzer as below: 

 

 

Put the calibration board on the support according to the instruction. The collection is same 

as above. When all five positions photos are captured, the software will calibrate the camera 

automatically. You will see the progress bar as below. 

  

The camera calibration may keep for a long time in 52%, please be patient. When IT is finished, 

you’ll see “Camera calibration success”. The software will enter Color camera white balance mode 

automatically. 

 

Camera Calibration 
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The software will enter HD calibration mode automatically after camera calibration.  

 
Put the calibration board according to the video, with the line plane facing the white smooth 

area at the back of the calibration board. Click  or  , move the scanner up and down, 

the software will collect the pictures until the distance bar is ticked. 

 
When the distance bar all ticked, the software starts to calibrate automatically. It will show 

“HD calibration success” when calibration is finished. If there is no color camera, click “Exit” to 

exit the calibration page, enter the scan mode selection page.  

HD calibration 
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Camera calibration 
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During the texture calibration, just place texture camera towards white area of the reverse 

side of calibration board, click  or  on the hardware, and move the scanner up and 

down, until one box is ticked, and the white balance test is completed. The picture below will 

show up when the calibration is successful. 

When calibration is finished, the software will close the calibration window automatically 

and enter the scan mode selection page. 

 

 

  

White balance calibration 
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You must finish all the calibration steps according to the instruction when you calibrate at the 

first time. If resolution is lost under HD Mode, or environment light changes and influences the 

scanning, you can do line calibration or white balance calibration solely. 

Situations as below need do calibration again: 

 

 

 

 

 

 

  

① When the scanner is used for the first time or after long time without using. 

② When there is strong vibration during the transportation. 

③ When alignment mistake or failure frequent appear during the scanning. 

④ When environment light changes under Color Scan, white balance calibration is 

needed. 

⑤ When scanning data is incomplete and quality is much worse during the scanning.  

Note: Make sure to keep the calibration board still and then click “Snap” to collect 

during calibration. 

 

Calibration Precautions 
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If markers can’t be recognized, tracking lost or misalignment happens often, you can do 

Accuracy Diagnostic. If the result of the tolerance is big, please recalibrate.  

Choose Accuracy Diagnostic from the calibration tool bar in the right, the way is same as 

camera calibration. Place the calibration board flatly, point the scanner cross on the middle white 

frame up and down slowly till all boxes getting green ticks.  

 

 

 

The result of the accuracy tolerance will be shown. Go back to scan mode selection page by 

clicking “quit” at the left bottom.   

 

Note: Recalibration is recommended when result is above 0.1mm. 

 

  

Accuracy Diagnostic 
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5 



28 
 

 

Choose Fixed Scan, click ‘Next’. 

 

        

Help Mode for Beginner is the default selection, which is to guide the new users make a scan 

completely step by step. Close Help Mode for Beginner by clicking the top right corner 

. To open Help Mode for Beginner, go to Menu -> User Setting ->Help 

Mode for Beginner 

 

Under the Help Mode for Beginner, following the guidance step by step, you will finish a scan 

following: New Project -> Texture/Non-texture ->adjust brightness -> start scanning -> Edit -> 

->Continue Scan/Mesh -> Mesh type: Watertight/ Un-watertight -> Post Processing -> Save data 

Help Mode for Beginner 
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Enter the interface of New Project and Open Project, the default project save location is the 

desktop, then it will remember where the user last created a new project. Click “New Project”, 

enter the project name, then click ‘Save’ to enter the interface of Non-texture Scan and Texture 

Scan selection. Texture scan is only active when the scanner is with texture camera.  

    

In the new project interface, select , can 

import three formats as asc, txt and p3. Note：the use of global markers file, the only point in the 

framework can scan. Global markers point can be deleted. 

 

Enter the interface and check “With Turntable ”. 

 

 

5.2.1. Before Scanning 

5.2.1.1. Camera viewport 

Tick   to display the right camera viewport and texture 

Fixed Scan 
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camera viewport. The left camera viewport always display. 

Click  in the lower right corner of the camera viewport to zoom the camera viewport  

 

5.2.1.2. Work distance  

Adjust the distance between the object and device (suitable working distance is 350 ~ 450mm), 

until the cross is clearly to be seen on the object. 

 

5.2.1.3. Adjust Brightness 

 Drag the button to adjust the brightness. The 

brightness is appropriate at the right scan distance: 

equipment against objects, the cross is clearly in the brightness viewing window. 

 

5.2.1.4. With Turntable 

 If you don’t choose “With Turntable” option, you will get single piece of 

data; if choose this option, the scanner will use turntable to scan and choose turntable steps as 

well as align mode. 
 

5.2.1.5. Turntable Steps 

Before scanning, you can set the scan times per round 

under turntable scan. The default setting is 8 times. 

 

5.2.1.6. Align Mode 

The default is turntable coded targets align mode，you can also choose 

markers or feature align mode. Align mode can be re-selected after the 

turntable has rotated one circle. 

 

If you import global markers point file when creating a new project, the align mode is global 

mark point, and the project cannot change to other align mode. In the new project interface, select

, can import three formats as asc, txt 

Fixed Scan 
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and p3. Import global mark point. Note：The use of global markers point, the only point in the 

framework can scan. 

 

 

 

5.2.1.7. HDR 

 Enable HDR brightness can scan bright and dark objects. 

 

 

5.2.2. Scanning 

5.2.2.1. Start Scan 

Click the button or press space button to start scanning. After the turntable has rotated 

one circle，you can change with turntable or not, turntable steps and align mode.  

 

5.2.2.2. Edit Tool 

Edit buttons: ①Deselect ②Revert ③Delete ④Undo ⑤Show/Hide 

Stripe ⑥Shift + Left mouse: choose data ⑦Ctrl + Left mouse: deselect 

selected data 

You can edit the current part data after each scan. You can do the below edition if the data has 

excess parts, both data and mark points can be edited. 

 

SHIFT+Left mouse：Select excess parts, the selected section is displayed in red, as shown below. 

 Note： 

1、 Choose turntable coded targets align mode, Please make sure that the object won’t 

block the coded targets on the turntable. Or, there will be no fringe pattern, while 

turntable will be still rotating. If the scanned object is too high and will block the 

coded target on turntable, you can stick mark points on it (if allowed) to continue 

auto scan. At this time, please make sure that the coded target on the turntable are 

covered, so as not to affect the scanning. Make sure that in each single scan area has 

at least 4 points. Refer to Scan Preparation. 

2、 Feature align, when scan it will verifying and scan 3 piece of data. 

Fixed Scan 
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Ctrl + Left mouse: deselect selected data 

 

Delete selected data 

Click the button or “DELETE” 

in the keyboard to delete selected 

data. 

 

Undo 

You can only undo the last 

deleted data. 

 

Show/Hide Stripes 

Click the button to switch the texture display and hide. Non-texture scan, there is no 

such button. 

 

5.2.2.3. End single-piece edit 

Click  or press space button to save data and exit the single-piece edition; Click 

, delete the current scan dat. 

After end the single-piece edit, the right toolbar will display, and now can edit the whole scan data. 

Fixed Scan 
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The specific operation is the same as the single-piece edit.  

5.2.2.4. Manual Align 

If automatic alignment failed during scanning, you 

can use manual align. Click the button to open 

Manual Align view port on the left side of the software. Keep 

SHIFT down, and click left mouse button to select at least 3 

non-collinear corresponding points in the 3D preview 

windows for Manual align, as shown on the right. 

Note: If you choose wrong points under manual alignment, 

you may press Esc button to cancel the points one by one in 

order, until you exit manual alignment. 

 

5.2.2.5. Delete Current Data 

 If you are not satisfied with current scanning data, or there is not enough overlapping 

region for registration, click the button to delete current data and then change the 

position of the scanner or the object to scan again. 

When auto scan mode is scanning, you can click the button to stop the current scan. The 

current data will be deleted directly.  

When import project, click the button and it will remove the single data. 

5.2.2.6. Pause 

  

Click the button, scanning will pause; Click again to resume scanning. 

 

 

5.2.3. After Scanning 

5.2.3.1. Mesh 

When the scan is completed, click the botton, proceed to post-processing. You will see 

two modes after clicking the button: Watertight and Unwatertight. Watertight usually 

slower than unwatertigt. Texture scan mode will take more time compared to Non-Texture scan 

mode.  

 

Watertight 

Fixed Scan 



34 
 

 Closed model can be printed directly. After choose this mode, you should select the 

object details. 

Select High for objects with fine texture, select Med or Low for objects in smooth surface 

or with less detail. The time for data processing is in relation to the detail setting. The higher the 

level of details is, the longer time the processing takes. It may keep for a long time in 95%, please 

be patient. 

 

Select the object details： 

 

 

Unwatertight 

 

Unclosed model. The following picture is the watertight and unwatertight model.  

 

           

Watertight                             Unwatertight 

 

Texture watertight results: 

Fixed Scan 
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5.2.3.2. Data Post Processing 

After meshing, the following dialogue box of data post processing will appear. You can simplify 

the data per your request, do fill holes, sharpening or smoothing operations. Unwatertight and 

watertight, the post processing of the interface as shown below. 

 

    
 

Data simplification 

After simplification, the polygon numbers, size and surface detail of data will be reduced 

accordingly. Check the simplify check box and set the ratio, the default is 100%. 

The comparison of detail between before simplification and after simplification (at 30% simplify 

proportion). 

 

Fixed Scan 
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Before simplification          After simplification  

 

Fill holes 

The default does not check the mark point and fill hole, check the fill hole you need set 

perimeter, choose 10-100mm perimeter to fill the hole, less than the perimeter of the hole will be 

filled. Mark point fill hole as an example.  

        

      Before              After 

 

 

Smooth 

The data to denoise processing, improve data quality, the figure before and after smoothing:  

 Note： 

1. If the edge of the hole is not smooth may cause the effect is not good, not 

recommended to fill hole. 

2. Hole-filling: choose 10-100mm perimeter to fill the hole; 

 

Fixed Scan 
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  Before smooth          After smooth 

 

Sharpen 

Improve the overall clarity of the data, the figure below before and after sharpening: 

         

  Before sharpen        After sharpen 

 

Optimize the texture 

This option is only available when the scan data is with texture. Click this function to optimize color 

texture of the model, which can make the color closer to the model but take more time for 

processing.  

       
Not optimize          Optimize  texture 

 

Texture layout optimization 

Fixed Scan 
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If you need to edit the texture later, you can select this function, but this is time-consuming. 

 

  

No optimization Texture layout optimization 

 

5.2.3.3. Brightness/Contrast 

After meshing project with texture, you may adjust brightness/contrast under the camera 

viewport.  

Brightness (-100—100): shows the brightness of the picture. The higher the value is, the brighter. 

Contrast (-100—100): shows the contrast of the colors. The higher the value is, the more color 

gradient layers. 

 

5.2.3.4. Save Your Data 

Before merging can save data as asc single. After merging, it can be saved as asc, stl, 

ply,3mf and obj.  

 

5.2.3.5. Scale 

Scaling the volume of scanning data, while the quantity of triangular facets and size of data will 

not be changed. 

Fixed Scan 
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 Scaling result as reference: From left to right shows double size, original size and half size 

respectively. 

        

Scale window                            Scale result 

5.2.3.6. Share Your Data 

Click the button after merging to share data, it will show the dialog as below. 

You can share your model to Sketchfab, while model title, username and user password 

are required. Register an account and look at the shared model at http://sketchfab.com.  

 

 

 

 Note： 

Sketchfab Normal account can only upload data maximum 50M, while Professional 

account can share maximum 200M, and set model as private. 

 

Fixed Scan 

 

http://sketchfab.com/
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5.2.3.7. Solid Edge 

If Solid Edge software is already installed, click the button  to open the software. The 

meshed STL data will also be exported to Solid Edge. 

5.2.3.8. Project 

You can new or open projects. The default project location is the desktop, then it will 

remember where the user last created a new project. 

 
 

 Note：  

1. The scanning projects created by different scan modes (Industry fixed scan, 

handheld HD scan and handheld rapid scan) cannot be reciprocally imported. The 

projects created by auto scan and fixed scan ( without turntable )  can be 

reciprocally imported.  

2. After importing the project, direct access to scan, choose the scan mode based on 

whether the imported project is texture. The texture project cannot be continued 

to scan if the scanner is without color texture camera. 

Fixed Scan 
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5.2.3.9. Back to Home 

 If you want to change the scan modes, click the button to go back to the homepage to 

select the scan mode. 

 

5.2.4. Others 

5.2.4.1. Mouse Operation Prompts 

Lower left corner of the interface is the mouse operation prompts: 

 

 Hold down the left mouse button: Rotate the object; 

 Hold down the middle mouse button: pan the object; 

 Hold down the mouse wheel: Scroll up and down to the object; scroll down to enlarge 
the object; 

 Hold down the Shift + left mouse button: select the area on the object; 

 Hold down the Ctrl + left mouse button: deselect selected data; 

 Delete: Delete the selected area. 

 Press and hold shift + left mouse click: Select point to start manual align 

5.2.4.2. Hot Key 

Space button: To start scan or during single-piece edit to save data and exit the single-piece edition. 

ESC button: To close the pop-up windows, such as new project, select texture, choose mesh type 

and so on. 

5.2.4.3. Points and Triangle 

When scanning it will show the current points and current triangles 

in the lower right corner. When you edit the scan data, the current 

points and the current triangles change in real time. 

 

5.2.4.4. Help 

Click this button to get the operation manual and notes in more detail under the current 

step. 

The following picture shows the help information of new project. 

Fixed Scan 

 

Fixed Scan 
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5.2.4.5. Model Viewer 

Einscan software can be a 3d viewer for ASC, OBJ, STL format file. Drag the 3d model to 

Einscan software under scanning mode interface.  

Click  on the 3d viewer window will close the model view. The scanning window will 

be not affected.  

 

Fixed Scan 
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You can use software without scanner connection. You can do edition, manual align, delete, mesh, 

save data, share data and so on. 

  

Fixed Scan 
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“ - ”“ + ”： During the 

scanning, zoom in and out 

in view of data  

under exposure window，

“-”“+”can adjust the 

 

 
Scan/pause button: click the 

button to pause or start 

scanning. 

Double click to activate 

exposure adjustment 

window. 

 

Scanning distance indicator: 

Green for best distance; blue 

for too far, red for too close. 

The color is same as the 

distance bar in operation 

interface. 

 

Scan head key function 
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Choose Handheld Rapid Scan, click “Next”, as shown below: 

 

 

Help Mode for Beginner is the default selection, which is to guide the new users make a scan 

completely step by step. Close Help Mode for Beginner by clicking the top right corner 

. To open Help Mode for Beginner, go to Menu -> User Setting ->Help 

Mode for Beginner 

 

Under the Help Mode for Beginner, following the guidance step by step, you will finish a scan 

following: New Project -> Texture/Non-texture, Resolution -> Preview-> Adjust brightness->start 

scanning ->Pause scanning -> End Edit -> Generate point cloud -> Continue scan/Mesh -> Mesh 

type: Watertight/ Un-watertight -> Post Processing -> Save data 

  

Help Mode for Beginner 



47 
 

 

6.3.1. Before Scanning 

Enter the interface of new project, as shown below, click “New Project”, type the project name, 

then will pop-up the interface of align mode, texture scan and resolution selection. Texture scan is 

only active when the scanner is with texture camera. The process of Non-texture Scan and Texture 

Scan are same.  

  

 

Select Resolution 

The higher the resolution, the better the details. If select the “More setting of Resolution”, 

you can drag the sliding block to other locations, flexible choice of point distance. 

Handheld Rapid Scan point distance range: 0.5mm—3.0mm, high 0.5mm, medium 1.0mm, 

low 1.5mm. 

 

 
 

Select Texture 

If texture camera is not attached, when you select texture,it will pop-up a dialog as shown below: 

 Note： 

1.Higher resolution takes more time to scan and consumes more memory of graphic 

card，and size of the object to be scanned will be limited. Theoretically, the maximum 

size of scan = point distance*8192/mm. In actual process, the size of the object can 

be scanned depending on computer graphic card.  

2. Choose high resolution, the data output is slow, please be patient. 

3. When import project, and continue the scan, the scanning will be in accordance 

with the imported project resolution and align mode. 

 

Handheld Rapid Scan 
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Select Align Mode 

 
When select markers or mixed align mode, if you have purchased R2,click “Active” and import the 

encode file; If you want to buy this function, please contact support

（einscan_support@shining3d.com）. 

 

 

 

Markers align mode relies on reflective mark points to align. Stick mark points on the object 

in random, avoiding sticking in one line, refer to scan preparation. 

 

When select markers align mode, you can tick 

, can import three formats as asc, txt 

and p3. Note：the use of global markers file, the only point in the framework can scan. Global 

markers point can be deleted. 

 

The interface of Handheld Rapid Scan: 

 

 Note： 

 Feature alignment is suitable for objects with rich features on surface. 

 Objects with plane, symmetric surfaces or lots of similar features are not recommended 

to use feature alignment but markers alignment. Markers should be placed on the entire 

surface of object but in a non-sequential way. 

 If you choose mixed alignment, the software can switch between feature and marker 

alignment automatically during scanning according to the surface of the scanned object 

(with markers or not). For some parts which are difficult for feature alignment, you may 

stick markers (≥4 markers) to help with alignment.  

 If you choose marker alignment mode and load in global markers, you can just scan 

objects within global markers; if you choose mixed alignment and load in global markers, 

you can scan objects beyond global markers. 

Handheld Rapid Scan 

mailto:einscan_support@shining3d.com
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6.3.2. Preview 

6.3.2.1. Camera viewport 

Tick   to display the right camera viewport and texture 

camera viewport. The left camera viewport always display. 

Click  in the lower right corner of the camera viewport to zoom the camera viewport  

 

6.3.2.2. Preview 

Point the scanner to the object, then click  on software or press  on 

scanner to run into PREVIEW mode. In this mode, it will start to capture data, but not recorded. In 

this mode, you can: 

1. Check working distance, and field of view for scanning; 

2. Adjust a proper brightness before scanning.  

 

Handheld Rapid Scan 
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6.3.2.3. Adjust Brightness 

1. When scanning distance is adjusted properly, double click  , and adjust the brightness by 

pressing “+, -“ button on the scanner. Double click  to exit the brightness adjustment. 

2. Brightness can be also adjusted via the brightness slider under the camera window 

 on the left side. 

3. Brightness can be adjusted during scanning. 

 

 

 

Handheld Rapid Scan 

 



51 
 

 

  

To bright(X) Good(√) To dark(X) 

 

6.3.2.4. Rangefinder 

Rangefinder is on the left side. It reveals different colors based on the distance between the 
scanner and the object. At the correct distance, it will show green. If it is too close it will show 
red and if it is too far it will show blue. Please adjust the scanner position until the rangefinder 
color turns green. 

 

 
 

 

Too Close Good Too Far 

When brightness adjustment is over, click   on the scanner or  in the software to 

start scan recording.  

 

Handheld Rapid Scan 
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6.3.3. Scanning 

6.3.3.1. Start scan 

Click the button or the button  on the hardware to start scanning. 

When start scanning, keep the scanner opposite to the object for 3 seconds, and start to move 

when scan data shows. To improve the scan efficiency, the movement should be continuous and 

uniform. 

Feature Align 

 If the scanning presents purple color and appears, and buzz, it 

indicates that the position tracking fails. You need to go back to the previous scan area and wait 

for about 3 seconds and adopt merging features for about several seconds, and then try to scan 

normally. 

 
 

 Note: 

1. Preview mode is needed every time for brightness adjustment when a new project 

is built or an existing project is imported for continues scanning. 

2. When open project, if click  , preview mode is no longer available. 

Handheld Rapid Scan 
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Mark point align 

Before scanning should stick mark points on the object in random,  refer to scan preparation, 

avoiding sticking in one line. The green area is the current scan, as shown below . 

When the position tracking fails, it will appear   , You need to go back to 

the previous markers to get to be tracked again to continue scan. 

 

 

 

Mixed Align 

For some parts which are difficult for feature alignment, you may stick markers (≥4 markers) to 

help with alignment. As shown below, markers only stick on the sphere and the rest of the model 

does not need to stick. 

 Note： 

1． When the scanned data quality is not good, please check the distance, and if the 

brightness is proper in good distance condition. Check brightness through exposure 

whether the light frame is clearly shooting on the object. 

2. During scanning, please face the scanner to the object. 

 

Handheld Rapid Scan 
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Texture Scan 

In the process of texture scan, if blue data appears, it means that no texture has been snapped in 

the region, so it is necessary to scan the area repeatedly. 

 

Handheld Rapid Scan 
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6.3.3.2. Pause 

Click the button or press the button  on the scanner to suspend scanning and check 

with it. After pause scanning and enter editing state, you can quit editing state and save 

the data by pressing the button on the device or clicking  in the lower right corner of 

the software. 

6.3.3.3. Edit Tool  

Edit buttons: ①Deselect ②Revert 

③Delete ④Undo ⑤Show/Hide Stripe 

⑥Shift + Left mouse: choose data 

⑦Ctrl + Left mouse: deselect selected data 

You can edit the current part data after each scan. You can do the 

below edition if the data has excess parts, both data and mark 

points can be edited. 

 

SHIFT+Left mouse：Select excess parts, the selected section is 

displayed in red, as shown below. 

 

Ctrl + Left mouse: deselect selected data 

 

Delete selected data 

Click the button or “DELETE” in the keyboard to delete 

selected data. 

 

Undo 

You can only undo the last deleted data. 

  

 
 

Show/Hide Stripes 

Click the button to switch the texture display and hide. Non-texture scan, there is no 

such button.  

 

 Note： 

Handheld scan mode does not support the deletion of mark points. Handheld rapid 

scan, feature align, use the edit button to delete all the data, continue scanning will 

restore the last deleted data. 

 

Handheld Rapid Scan 
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6.3.3.4. End editing 

After pause scanning and enter editing state, as shown below, the icon  will show up in the 

lower right of the window, click this icon after editing is finished to save scanning data. A prompt 

box will pop up after clicking , the editing will be applied if you click “yes” and the deleted 

data will be irrevocable; if you click “no”, the editing will not be saved and the deleted data will be 

revoked; if you choose to continue editing, the software remains current state. 

 

6.3.3.5. Generate point cloud 

Click the button after finishing scanning, you’ll have two options, Quality Priority and 

Speed Priority. If you choose Quality Priority, it can optimize the scan data, but consume 

more memory and take more time. 
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Quality Priority          Speed Priority 

Note: You may press Esc button to close the popup. 

 

 

6.3.3.6. Delete Your Data 

Click the button to delete the whole data and restart scanning.  

 

 

6.3.4. After Scanning 

6.3.4.1. Mesh 

When the scan is completed, click the botton, proceed to post-processing. You will see 

two modes after clicking the button: Watertight and Unwatertight. Watertight usually 

slower than unwatertigt. Texture scan mode will take more time compared to Non-Texture scan 

mode.  

 

Watertight 

 Closed model can be printed directly. After choose this mode, you should select the 

object details. 

Select High for objects with fine texture, select Med or Low for objects in smooth surface 

or with less detail. The time for data processing is in relation to the detail setting. The higher the 

 Note： 

1. When new project choose the high resolution, the slow it saves, please be patient. 

2. After click ” Finish Scan”， if you continue to close the program Data loss may 

occur. Please wait. 

 

Handheld Rapid Scan 
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level of details is, the longer time the processing takes. It may keep for a long time in 95%, please 

be patient. 

 

Select the object details： 

 

 

 

 

 

Unwatertight 

 

Unclosed model. The following picture is the watertight and unwatertight model.  

 

      

 Note： 

1. Select High for objects with fine texture, select Med or Low for objects in 

smooth surface or with less detail. The time for data processing is in relation to 

the detail setting. The higher the level of details is, the longer time the 

processing takes. 

2. Watertight usually slower than unwatertigh, high resolution takes more time, 

it may keep for a long time in 95%, please be patient. 

Handheld Rapid Scan 
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   Watertight                            Unwatertight 

 

Texture watertight results are shown in the picture: 

 

 

6.3.4.2. Data Post Processing 

After meshing, the following dialogue box of data post processing will appear. You can simplify 

the data per your request, do fill holes, sharpening or smoothing operations. Unwatertight and 

watertight, the post processing of the interface as shown below. 

      
 

Data simplification 

After simplification, the polygon numbers, size and surface detail of data will be reduced 

accordingly. Check the simplify check box and set the ratio, the default is 100%. 

The comparison of detail between before simplification and after simplification (at 30% simplify 

proportion). 

Handheld Rapid Scan 
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      Before simplification          After simplification 

Fill holes 

The default does not check the mark point and fill hole, check the fill hole you need set 

perimeter, choose 10-100mm perimeter to fill the hole, less than the perimeter of the hole will be 

filled. Mark point fill hole as an example.  

      

     Before          After 

 

 

Smooth 

The data to denoise processing, improve data quality, the figure before and after smoothing:  

 Note： 

3. If the edge of the hole is not smooth may cause the effect is not good, not 

recommended to fill hole. 

4. Hole-filling: choose 10-100mm perimeter to fill the hole; 

 

Handheld Rapid Scan 
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  Before smooth          After smooth 

 

Sharpen 

Improve the overall clarity of the data, the figure below before and after sharpening: 

         

  Before sharpen        After sharpen 

 

Optimize the texture 

This option is only available when the scan data is with texture. Click this function to optimize color 

texture of the model, which can make the color closer to the model but take more time for 

processing.  

       
Not optimize          Optimize  texture 

 

Texture layout optimization 

Handheld Rapid Scan 
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If you need to edit the texture later, you can select this function, but this is time-consuming. 

 

  

No optimization Texture layout optimization 

 

 

6.3.4.3. Brightness/Contrast 

After meshing project with texture, you may adjust brightness/contrast under the camera 

viewport.  

Brightness (-100—100): shows the brightness of the picture. The higher the value is, the brighter. 

Contrast (-100—100): shows the contrast of the colors. The higher the value is, the more color 

gradient layers. 

 

6.3.4.4. Save Your Data 

Before merging can save data as asc . After merging, it can be saved as asc, stl, ply,3mf and 

obj.  

 

6.3.4.5. Scale 

Scaling the volume of scanning data, while the quantity of triangular facets and size of data will 

Handheld Rapid Scan 
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not be changed. 

 Scaling result as reference: From left to right shows double size, original size and half size 

respectively. 

        

Scale window                            Scale result 

6.3.4.6. Share Your Data 

Click the button after merging to share data, it will show the dialog as below. 

You can share your model to Sketchfab, while model title, username and user password 

are required. Register an account and look at the shared model at http://sketchfab.com.  

 

 

 

 Note： 

Sketchfab Normal account can only upload data maximum 50M, while Professional 

account can share maximum 200M, and set model as private. 

 

Handheld Rapid Scan 
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6.3.4.7. Solid Edge 

If Solid Edge software is already installed, click the button  to open the software. The 

meshed STL data will also be exported to Solid Edge. 

 

6.3.4.8. Project 

You can new or open projects. The default project location is the desktop, then it will 

remember where the user last created a new project.  

 

 
 

 Note: 

1. Handheld rapid scan will follow whether the imported project is mark point align or 

feature align. If imports a mark point align project or global mark point project when 

there is no such function, you can’t do further scan but only edit or merge the project. 

2. Handheld scan mode: When import project, and continue the scan, the scanning will 

be in accordance with the imported project resolution. 

Handheld Rapid Scan 
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6.3.4.9. Back to Home 

If you want to change the scan modes, click the button to go back to the homepage to select 

the scan mode. 

 

6.3.5. Others 

6.3.5.1. Mouse Operation Prompts 

Lower left corner of the interface is the mouse operation prompts: 

 

 Hold down the left mouse button: Rotate the object; 

 Hold down the middle mouse button: pan the object; 

 Hold down the mouse wheel: Scroll up and down to the object; scroll down to enlarge 
the object; 

 Hold down the Shift + left mouse button: select the area on the object; 

 Hold down the Ctrl + left mouse button: deselect selected data; 

 Delete: Delete the selected area. 

6.3.5.2. Hot Key 

ESC button: To close the pop-up windows, such as new project, select texture, choose mesh type 

and so on. 

6.3.5.3. Frame rate, Points, Triangle 

When scanning it will show the Frame rate, current points. After 

merging, it will show current triangles in the lower right corner. 

Handheld Rapid Scan’s scan speed is 10 frames/sec. When you edit 

the scan data, the current points and the current triangles change in real time. 

 

6.3.5.4. Help 

Click this button to get the operation manual and notes in more detail under the current 

step. 

The following picture shows the help information of new project. 

Handheld Rapid Scan 
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6.3.5.5. Model Viewer 

Einscan software can be a 3d viewer for ASC, OBJ, STL format file. Drag the 3d model to 

Einscan software under scanning mode interface.  

Click  on the 3d viewer window will close the model view. The scanning window will 

be not affected.  

 

Handheld Rapid Scan 
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6.3.6. Work Offline 

You can use software without scanner connection. You can do edition, manual align, delete, mesh, 

save data, share data and so on. 

  

Handheld Rapid Scan 
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HD scan relies on reflective mark points to align. Stick mark points on the object in random, 

avoiding sticking in one line. 

 
 

Choose Handheld HD Scan mode, click”Next”. 

 

After new project, select resolution. The higher the resolution, the better the details. If select 

the “others”, you can drag the sliding block to other locations, flexible choice of point distance. 

 

Select resolution 

Handheld HD Scan point distance range: 0.2mm—3.0mm, high 0.2mm, medium 0.5mm, low 

1.0mm. 

 

 Note： 

The single scan range is 210mm X 150mm, public areas alignment require at least 

four mark points. While placing the points, uniformly stick the mark points on the object, 

and make sure that in each single scan area has at least 4 points. 

 

Handheld HD Scan 
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6.4.1. Preview 

6.4.1.1. Preview 

Point the scanner to the object, then click  on software or press  on 

scanner to run into PREVIEW mode. In this mode, it will start to capture data, but not recorded. In 

this mode, you can: 

3. Check working distance, and field of view for scanning; 

4. Adjust a proper brightness before scanning.  

Note: You need to preview objects with markers. 

 
 

6.4.1.2. Adjust Brightness 

1. When scanning distance is adjusted properly, double click  , and adjust the brightness by 

pressing “+, -“ button on the scanner. Double click  to exit the brightness adjustment. 

2. Brightness can be also adjusted via the brightness slider under the camera window  on the left 

side. 

3. Brightness can be adjusted during scanning. 

Handheld HD Scan 
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To bright(X) Good(√) Too dark(X) 

 

When brightness adjustment is over, click   on the scanner or  in the software to 

start scan recording.  

 

Handheld HD scanning interface as follows: 

 

6.4.2. Others 

Edit, finish scan, delete data, mesh, save data and share refer to Handheld rapid Scan. 

  

Handheld HD Scan 
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1.  What if no scan data when the turntable has rotated one circle? 

Solution: Please make sure that the object won’t block the mark points on the turntable. Or, there 

will be no fringe pattern, while turntable will be still rotating. If the align mode is mark point, please 

make sure that the marks on the turntable are covered, so as not to affect the scanning. Make sure 

that in each single scan area has at least 4 points. 

 

2. What if the merging fails without mark points when the turntable has rotated several circles or 
when it is under fixed scan ( without turntable ) mode? 

Solution: Try to make sure there are at least 1/3 overlap between the current scan area and the 

previous scan area and the object surface should be featured. For objects which are symmetric and 

without rich features, using mark points or manual merger is recommended. 

3. How to scan objects in transparent, semi-transparent or black? 

Solution：Scan before spraying on the surface. 

 

4. Under handheld HD mode and handheld rapid mode, what if there are straggling points? 

Solution：（1）Adjust the brightness, until the reflected graph and mark points are clear to be seen.

（2）Try to make sure the background environment is single, for example, to use a black cloth or 

500mm away from other objects.（3）Do not scan opposite to the computer screen. 

5. Under Handheld HD mode, what if only the mark points could be identified while there is very 
less data captured? 

Solution：Please do the HD scan calibration again，and during the calibration and capturing graph, 

please make sure the calibration board and scan head are still. 

 

6. Under handheld rapid mode, how to continue scanning when the merging fails? 

Solution：Please move back to the scanned part (unreformed) for 3 seconds where there are 

features and details, start to scan again when it is followed to scan. 

 

7. How to scan thin-walled workpiece? 

Solution：First, scan thin-walled parts should have transition zone which can stick with markers to 

guarantee scanning can be transited from one side to another. Then follow the following steps. 

(1) Stick markers on the transition zone. Make sure from the camera viewport, there are no less 

than 4 mark points evenly distributed and not in one line. 

  

FAQ 
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(2) Scan markers on the workpiece rapidly. Do spiral rotating via transition zone. Scan as many mark 

points as possible on both sides and transition zone to build frame. The faster, the better. 

 

  
(3) After building frame, scan the surface of workpiece slowly and carefully to finish the whole scan. 

FAQ 
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8. Under auto scan mode, if the turntable is not moving, but with a humming sound, how to solve? 

Solution：Disconnect power line and connect again in few seconds. 

 

9．How to solve if after scan there is no data? 

8. Solution：Open control panelRegion, then click “Additional settings”, decimal symbol 
choose “.” 

 

  

FAQ 
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 Keep well-ventilation. Environment temperature shall below 40 Celsius degree, and do not 

use the device under an environment with flammable or corrosive gases or another similar 

environment. 

 

 Please grab and place gently in the proper position, and do not squeeze it. Prepare 

precautions like sunscreen, rain-proof, shock-proof and etc. No matter on sunny or rainy days. 

  

 If the device could not function correctly, fixing the device by opening it by yourself is not 

allowed. The device shall be repaired by professional technicians or under their instruction. 

  

 You should send the device to facilities with qualification for recycling it instead of dropping 

into the household garbage when it is scrapped. 

  

Safety Precautions  
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Contact us 

Email: einscan_support@shining3d.com 

 

More scanning information 

More scanning information can refer to http://www.einscan.com ---Support 

 

 

Contact Us 

mailto:einscan_support@shining3d.com
http://www.einscan.com/
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